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Electronic Models 
 
►Introduction The advent and use of molecular modeling has revolutionized the science of 
organic chemistry. In 2004, Spartan was acquired by the Physical Sciences Department of 
Prince George’s Community College and installed on the computers in the Computer Lab, 
CH 309. Spartan is a program with multiple capabilities. In CHM 201, we are most interested 
in three basic capabilities of Spartan to build models of molecules, to view these models in 
five different formats, and to measure distances and angles on a model. The more advanced 
capabilities will be explored in CHM 204. This experiment consists of three parts, a tutorial 
in the three basic capabilities of Spartan, a group of practical exercises and a set of 10 
questions. The tutorial is designed to be a learning primer and a user’s guide. You can refer 
to it at any time to refresh your memory about specific capabilities of Spartan. The practical 
exercises are designed to reinforce the knowledge you have acquired in the first three weeks 
of organic chemistry in a game-like and fun manner. The questions test your understanding 
of the models and some chemistry. The basic operations of the program are described, 
including basic mouse commands and certain screen features as well as Menu Bar items and 
Toolbar icons. Then, we will explore Spartan by following a normal pattern that a typical 
user follows. We will build models of molecules, explore the various ways of viewing them, 
and make measurements on them. Thus, we will build, view, and measure. The goal is to 
make you proficient in the use of Spartan, so that you can use it throughout the course as a 
learning enhancer. 
 
Spartan Tutorial 
 
►Open Spartan 
Open the Spartan program from the list of academic programs. The Spartan icon is shown 
below. 
 

Spartan `04 V1.0.0.lnk  
 
The electronic model kit should appear. In turn, click (1) File, (2) New and (3) Maximize, as 
shown below. (Alternatively, click the “New” icon and then “Maximize.”) 

1
2 3

 
 
The program is now ready to use. 
 
If you cannot open Spartan, ask the instructor for help. With Spartan and the Lab 3 Word file 
“Electronic Models” open, the two icons for these files should be visible on the bar at the 
bottom of the screen. To toggle back and forth between the two files simply click on the W 
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(Word icon for Electronic Models) at the bottom of the screen. Click the W several times to 
go back and forth from this tutorial to Spartan. 
 
 ●General Commands The command to click means to depress the left mouse key 
(LMK) one time. Double click means to depress the LMK twice in rapid succession. When 
the right mouse key is required, it will be specifically identified as RMK to distinguish it 
from the LMK. The mouse controls a white arrow or pointer on the screen. Move your 
mouse to see the motion of the pointer. The command to “click on …” means to place the 
pointer on the specified object and depress the LMK. 
 
►Screen Features◄ Spartan initially opens with several visible features. Some 
of these features will be described briefly here for familiarization and in more detail, as 
necessary, later. Some advanced features will not be discussed. 
 

Title Bar Menu Bar Toolbar

Model Kit

Selected item

Insert ButtonOperational Command

 
Figure 1. Screen features  
 

●Title Bar  
The left side of the title bar contains the logo, S, and name of the program (Spartan 

‘04). The right side of the title bar contains three standard command boxes.                                         
 

                  ◦Minimize, Maximize, and Close There are three boxes on the right-hand side of 
the title bar. Place the pointer over each box until the name of the box appears. The name will 
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remain visible for approximately five seconds. These are standard commands. When you 
clicked on the middle box or “Maximize,” you opened a full screen. Otherwise, the bottom 
portion of Spartan is obscured by the Windows data bar at the bottom of the page. Click on 
File, New and Maximize every time you open Spartan; alternatively, click the File icon and 
Maximize. Note that the Maximize box becomes “Restore Down” after you have clicked it. 
 
 ●Menu Bar The Menu Bar (Figure 1) is the horizontal group of ten names, eight on 
the left side and two on the right side, starting with File on the left. Click on “File” and the 
File menu becomes visible. Slowly move the pointer from left to right across the Menu Bar. 
As the pointer passes each menu item, the contents of that menu item become visible. We 
will explore these items later. Clicking on any menu item allows you to read the contents of 
any other menu item by moving the pointer over the menu name 
. 
 ●Toolbar The Toolbar (Figure 1) is the horizontal group of eleven icons, starting 
with the File icon. The icons are shortcuts to Menu items. Click on each icon in turn, starting 
with the V icon. Note that a command appears in the lower left corner of the screen each time 
a new icon is clicked. See “Operational Command” in Figure 1. The command tells the 
viewer what to do next. For example, clicking the + icon results in the command to “Select a 
free valence.” Click on the “+” icon. Note that the selected icon appears slightly depressed 
with respect to the other icons. The name of the + icon is Add Fragment. The + icon is more 
commonly called the build icon, but its name on the Toolbar is Add Fragment, which means 
build. When you activate Spartan with the clicks noted above, the build icon is active.  
 
 ●Model Kit The Model Kit (Figure 1) is on the right side of the screen. It resembles a 
standard model kit. You can select atoms from the kit and use the atoms to build models of 
molecules. The kit contains 20 different individual atoms and two sets of bonded atoms in the 
form of groups or rings from which to choose. 
 
  ◦Individual Atoms In turn, click on several of the individual atoms in the kit. 
Note that the selected atom changes from black on a white background to white on a black 
background. A graphic of the selected atom appears in the box just above the 20 symbols.  
 
  ◦Groups What is a group? A group is not a complete molecule but a partial 
structure of two or more atoms joined by covalent bonds. Other atoms must be bonded to a 
group before it becomes a molecule (i.e., before the molecular model is complete). If you do 
not complete the model by adding other atoms, the program will automatically complete the 
molecule for you by adding H atoms when you try to make a measurement on the model or 
view it in another form. Click on “Groups” then click on the adjacent drop-down menu “▼.”  
A menu of 12 groups opens. Click on “Amide.” The structure of an amide group appears in 
the box above the kit. Draw this structure on a piece of paper for practice. 
 
  ◦Rings What is a ring? A ring is group of atoms joined by covalent bonds in a 
continuous loop. You may start at any atom that is part of the ring and follow bonds from one 
ring atom to the next until you return to the starting atom. From the Edit menu, click on 
“Clear” to clear the screen. Click on “Rings” then click on the adjacent “▼.” A dropdown 
menu of eight rings opens. Click on “Cyclopentane” and draw the structure of 
cyclopentane as it appears above the kit.  
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 ●Insert The Insert button (Figure 1) is located at the lower right corner of the screen. 
Two distinct and independent models can be built and viewed on the screen simultaneously. 
Build the first model, and then click on “Insert” and build the second model. Thereafter, 
additional models can be built and viewed simultaneously by clicking on Insert before 
building each model. Each model in the set can be moved or rotated independently of the 
others on the screen. Before we continue, the screen should be clear. If your screen is not 
clear, click on “Edit” from the Menu Bar and then click on “Clear.”  
 
►Menu Bar Items Look at the top of the screen; you see “Spartan.” On the next line, you 
see eight menu items on the left side of the screen and two on the right. On the left side, you 
see “File, Edit, Model, Geometry, Build, Setup, Display and Search.” On the right side, you 
see “Options and Help.” We will explore some of these menu items one at a time but not 
exactly in the order they appear on the Menu Bar.  
 

●File Click on “File” to open the File menu. You see 11 options. Most of these 
commands are self-evident. The commands “New Molecule, Delete Molecule, and Append 
Molecule(s)” will become evident in time. 
 
►Build◄ The building of models is associated primarily with the Build Menu. 

 
●Build A Spartan user normally builds, views, and measures in that order. Thus, 

we’ll start with the Build Menu. Likewise, because the Zoom, Rotation, Translation and Spin 
operations are really part of the build process. We’ll consider these functions before we 
continue with the other Menu Bar items. From the Menu Bar, click on “Build.” The Build 
menu consists of six options. The first option is View. View is not a build tool. View is more 
appropriately used with the Model Menu and will be discussed there. View is an option in the 
Build Menu to provide redundancy. The next four options in the Build menu are basic 
building tools.  
   

◦Add Fragment With the screen clear, click on the “Add Fragment” option 
from the “Build” menu. Note that the + icon on the Toolbar is active. Adding a fragment is 
the most fundamental operation of “Build.” We will build methane, the simplest 
hydrocarbon. Go to the Model Kit, click on the “C” with four single bonds. The C becomes 
active (highlighted). Click anywhere in the green area. A carbon atom with four single bonds 
(methane) appears, but its H atoms are not immediately apparent. Notice that the four bonds 
coming from the gray carbon atom are yellow. The yellow bonds initially represent either an 
H atom or a free valence, to which another fragment may be added. When you are finished 
building your model, the program will automatically add H atoms to any free valence (yellow 
bond). However, we are still in the build mode. Before continuing with the build options, 
some useful operations related to building molecules will be introduced. 

 
  ◦Minimize Click on “Minimize” from the “Build” menu. Note that hydrogen 
atoms automatically appear bonded to all free valences (available bonding sites), and the 
yellow bonds now appear gray. When the hydrogen atoms appear, the molecule is said to 
“sprout” hydrogens. The Minimize command builds the most stable (lowest energy) model of 
methane. The model built with the Minimize command is called a ball and spoke model. That 
is, the atoms are spheres, and the bonds joining atoms are spokes. The carbon atom is gray, 
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and the four hydrogen atoms are white. The colors are not pure but slightly off color (i.e., 
hydrogen is an off-white color). 
 

 ■Selecting Minimize or the E icon also calculates the energy of the molecule, 
which is shown at the lower right corner of the screen. What is the energy of methane 
in kcal/mol?  
 
►Zoom (Enlarge—Reduce Model) 
Depending on the application, it might be desirable to increase or reduce the size of a 
molecule. The zoom feature allows us to change the size of the displayed molecule. 
 
 ● Start with the white arrow (pointer) at the bottom of the screen. Depress and hold 
the “Shift” key on your keyboard. Simultaneously, depress and hold the RMK. With both 
keys depressed, move the pointer upward to the top of the screen. This operation increases 
the size of your methane molecule. Release the mouse key and return the white arrow to the 
bottom of the screen. Again, hold both keys (Shift + RMK) down and move the white arrow 
to the top of the screen. You can repeat this operation until you make the molecule the size 
you desire. Depressing both keys (Shift + RMK) and moving the pointer downward reduces 
the size of the model.  
 
 ●The larger the methane molecule appears, the easier it is to see the three 
dimensional aspects of the model. You may increase or decrease the size of models during 
the remainder of this tutorial to suit your needs. 
 
►Rotation of Whole Molecule A molecule rotates when it tumbles in any direction (three-
dimensions) about a stationary point. Rotation does not imply movement through space.  
 
 ●Move the white arrow (pointer) until it is just above your methane molecule. 
Depress and hold the LMK. Simultaneously move the mouse so that the white arrow makes 
circles around your methane molecule. Notice what happens when you simultaneously hold 
the LMK and swirl the mouse. With a combination of up or down and clockwise or 
anticlockwise swirls with the mouse, you can orient the molecule in any manner you please. 
 
 ●For practice, orient your methane molecule three different ways, as shown in Figure  
2. 
 

 
Figure 2. Orientations of methane. 
 



                              8

►Translation When a molecule moves through space by changing its three-dimensional or 
x, y, z coordinates, the molecule is undergoing translational motion. Translation does not 
imply spinning. 
 
 ●Depress and hold the RMK, then move the pointer up and down and right and left in 
the green area of the screen. These operations allow you to position the molecule any place 
on the screen you desire. The model moves from one location to another by translation. 
 
 ●For practice, move your methane molecule, in turn, to each corner of the screen. 
From the Edit menu, click on “Center.” The model moves to the center of the screen. 
 
 ■ Can a real molecule undergo rotation and translation at the same 
time? Can a molecule in Spartan undergo rotation and translation at the same 
time? Explain the difference between rotation and translation of a molecule. 
  
  ◦Add Fragment (Continued from above) Click the + (Add Fragment) icon 
to return to the build mode. The model on the screen can now be modified. The four bonds of 
carbon are yellow. The tips of the yellow bonds are free valences or available bonding sites. 
Note that the command line at the bottom left of the screen reads, “Select a free valence.” A 
free valence is a yellow tip. Click at the very end of any one of the yellow tips. An ethane 
model is built, because the C atom in the Model Kit with four single bonds is still active. You 
can add as many fragments as you please. Click on another free valence and propane is built. 
Click on an end-carbon’s free valence twice more, and pentane is built. Click on “E” the 
Minimize icon and the molecule appears in its most stable conformation with its hydrogen 
atoms visible. 
 
►Rotation About a Selected Bond (Spin) Two common properties of organic molecules 
are the rotation about carbon—carbon single bonds and the restricted rotation about multiple 
bonds.  
 
  ●With pentane on the screen, depress the “Alt” key on the keyboard. Depress and 
hold the LMK and move the mouse up and down. This action causes rotation (spinning) 
about the last-made single bond, which is indicated by a red ribbon around the bond. Click in 
the middle of one of the other carbon—carbon bonds. This changes the red ribbon to the 
desired bond. Then repeat the “Alt + LMK” procedure to rotate about the new bond with the 
red ribbon.  
 
►Changing a Bond Length A bond highlighted by a red ribbon may be elongated or 
shortened. You might want to do this to get a better view of a portion of a molecule. 
 

 ●With pentane on the screen, depress the “Alt” key on the keyboard and the RMK. 
Move the mouse up and down while depressing the “Alt” key. The bond is lengthened when 
the mouse is moved upward and shortened when the mouse is moved downward. The 
operation works only on the highlighted bond.  
 
►Spinning a Molecule Spinning differs from rotation in that spinning is two-dimensional 
and rotation is three-dimensional.  
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 ●With pentane on the screen, simultaneously depress “Shift + Ctrl” on the keyboard. 
Depress the LMK and move the cursor upward. The model makes a clockwise spin. Move 
the cursor downward and the model makes a counterclockwise spin. 
 
  ◦Delete Click on “Delete” from the “Build” menu. The command line (lower 
left corner) reads, “Select object to delete.” Do not click on a free valence, but click on the 
center of a terminal carbon atom. A methyl group is deleted, leaving butane. 
  ◦Make Bond Click on “Make Bond” from the “Build” menu. You are going 
to make cyclobutane by joining the end carbon atoms of butane. The command line reads, 
“Select two free valences.” What are free valences? They are the yellow ends of bonds. Do 
not click carbon atoms, they are not free valences. Click on two yellow tips in succession. 
First, click on a free valence at one end of your butane model. Then, click on a free valence 
at the other end of the molecule. By selecting two free valences, you created a bond joining 
their carbon atoms (i.e., cyclobutane.). Click the “E” icon and, if necessary, rotate the model 
to get a better view of it. You should have a nice model of cyclobutane. 
  ◦Break Bond Click on “Break Bond” from the “Build” menu. With Break 
Bond selected from the Build menu, click on the center of any carbon—carbon bond. Yellow 
tips appear where the bond breaks, creating two free valences. Although the yellow color 
between the two carbon atoms indicates that a bond has broken, it is sometimes difficult to 
see the new bonds. Click on the “E” icon. When the model adjusts to its most stable 
conformation, the new bonds of butane become clearly visible. 
   

●Edit Click on “Edit” to open the edit menu. You see several options, including 
“Undo, Copy, and Clear.” The “Undo” and “Copy” commands work just like they do in 
Word. Clicking “Undo” deletes the last command you made. Clicking “Copy” copies the 
structure to a  clipboard from which it may be pasted to another file.  

 ◦Clear This command clears the screen. Unlike the Exit command in the File 
menu, Clear allows you to continue building models. Click on “Clear.” The butane model 
disappears, and you are back in the build mode. Click anywhere in the green space and 
methane reappears (the C atom with four bonds is still highlighted in the Model Kit). Click 
on the very end of one of the yellow tips (free valence). A methyl group (the highlighted 
fragment in the kit) is now bonded where you clicked, making ethane. Click on “Undo” from 
the “Edit” menu. The methyl group added by your last command is deleted, leaving methane. 
Click on “E”. Methane appears as a “Ball and Spoke” structure.  
 
●Building Multi-atomic and Multiple Molecules  
 
 ●Multi-atomic Molecules  
 

●Alkanes Building complex molecules involves adding fragments. Build 
methane and click the + icon. Highlight the tetrahedral carbon in the kit. Click on one of the 
yellow tips and ethane appears. Click on an end carbon’s yellow tip again and you get 
propane. Continue until you have made pentane. Click on “E” then “V.” Zoom the molecule 
and note the clarity of the apparent three-dimensional structure. 

 
  ●Alkenes From the Edit menu, clear the screen. The Add Fragment (+) icon is 
active. Highlight a double-bond carbon in the Model Kit. Click on the screen. Click on the 
end of the double yellow lines and a double bond between two carbon atoms appears. Clear 
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the screen. Click on the screen, and a double bond fragment appears. This time click on one 
of the single yellow lines. A single bond is formed between the two carbon atoms, making 
two double bonds available. An important feature of the build mode is that like valences must 
bond to like valences.  
 
  ●Alkynes Clear the screen. Highlight the triple bond carbon in the Model Kit. 
Click on the screen. Click on the three-line bond and you get a triple bond. Click on the one 
line bond and you get a single bond. Like valences bond to like valences. 
 
  ●Oxygen There are two choices for oxygen atoms, one with two single bonds 
and one with a double bond. Clear the screen and build a methane model. Highlight the 
double bond oxygen and click on a yellow tip. You get an audible no-no, meaning that you 
have tried to join unlike valences. To add a double-bond oxygen to an existing fragment, the 
fragment must have a double bond site open. Clear the screen, click on a double bond carbon 
in the kit, then on the screen. Highlight the double bond oxygen and click on the double bond 
on the screen. A carbon—oxygen double bond appears. You have a carbonyl (carbon + 
oxygen) group. This is an important group in organic chemistry. Highlight the single bond 
oxygen in the Model Kit and click on a yellow single bond on the screen. You have a 
carboxyl (carbonyl + hydroxyl) group, another important group in organic chemistry. 
 
  ●Other Heteroatoms The other atoms in the kit are manipulated exactly as 
oxygen is manipulated. There are five options for nitrogen. Take care to bond like valences. 
You will get a no-no signal if you try to join unlike valences (i.e., a single bond to a double 
bond). 
 
  ●Groups Clear the screen. Click on “Groups” and select “Carboxylic Acid” 
from the dropdown menu. Click on the screen and the carboxyl group appears. Add a methyl 
group to the free valence from carbon and click “E”. Acetic acid appears. The other six 
groups work similarly. 
 
  ●Rings Clear the screen. Click on “Rings” and select “Cyclohexane” from the 
dropdown menu. Click on the screen and on “E” and cyclohexane appears. The other seven 
ring commands work similarly. 
 
 ●Multiple Molecules on the Screen Multiple models are made by clicking “Insert.” 
Build the first model as usual, then click “Insert” and build the next model, etc. Build a 
model of methane, click “Insert” and build a model of ethane. The models can be moved or 
rotated individually or as a group. The rotation and translation commands, given above, 
move the entire set of molecules on the screen. To rotate or translate individual molecules, 
the program must be in the build mode. Highlight one of the molecules by clicking on it. 
Depress “Ctrl” and use the LMK to rotate the highlighted molecule. Depress “Ctrl” and use 
the RHK to translate the highlighted molecule. Move the model around and then clear the 
screen. 
 
Note that the five basic commands available in the Build Menu are also available on the 
Build Toolbar, as shown in the graphic below. 
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Build Toolbar

 
 
►View◄ The viewing of models is associated primarily with the Model menu. 
 

●Model Build a methane molecule. Click on “Model” to open the model menu. The 
first five options provide five different ways to view a molecular model in Spartan. These 
five options are “Wire, Ball and Wire, Tube, Ball and Spoke, and Space Filling.” Two 
additional options we shall use are “Hydrogens and Labels.” They allow us to remove 
hydrogen atoms from a model if we wish, or to label all of the atoms or defined planes in the 
molecule. Note that the “Ball and Spoke” model and “Hydrogens” commands are already 
selected. The selected items in the “Model” menu define the picture on the screen. Thus far, 
we have been in the build mode. We cannot change the model from “Ball and Spoke” until 
we are in the view mode. Click on the “V” icon on the toolbar to change the mode from build 
to view.  

 
 ◦With the V icon active, click on “Wire” from the “Model” menu. The 

methane molecule now appears as a wire model. 
 
 ◦With the V icon active, click in turn on “Ball and Wire,” “Tube,” “Ball and 

Spoke,” and “Space Filling” from the “Model” menu. These names describe the models 
shown on the screen. These options allow you to view a molecule in the way that best allows 
you to gain the information you seek. 

 
 ◦With the V icon active, click on “Ball and Wire” to return to that model of 

methane, and then click on “Hydrogens” from the “Model” menu. Clicking on “Hydrogens” 
removes the check from the menu and also removes the hydrogens from the screen, leaving 
only the carbon atom of methane visible. Click on “Hydrogens” to restore the H atoms to the 
model. The default condition is for the H atoms to be visible. 

 
 ◦With the H atoms visible and methane as a ball and wire model, click on 

“Labels” from the “Model” menu. Each atom is labeled. With each atom labeled, two or 
more people can view the model and have a common frame of reference. Click on “Labels” 
to remove the labels from the model. The numbering system in “Labels” is not the same as 
the IUPAC system and is not consistent from one molecule to the next. Therefore, labels are 
normally used for the limited purpose of identifying atoms for a specific molecule that is 
visible on the screen. 
 
►Measure◄ The making of measurements on models is associated primarily with 
the Geometry menu. 
 
 ●Geometry Click on “Geometry” to open the geometry menu. You see three 
command options at the top of the menu. These three options are commands that allow us to 
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measure various aspects of a molecule. The measurement commands are “Measure Distance, 
Measure Angle, and Measure Dihedral.” The “Measure Distance” command allows us to find 
the distance between any two atoms in a model in Angstrom units (Å); the two atoms need 
not be bonded to each other. The “Measure Angle” command allows us to measure any angle 
in degrees (º) made by three atoms. The “Measure Dihedral” command allows us to measure 
a dihedral angle in degrees (º). A dihedral angle is an apparent angle made by four atoms. 
Two additional command options in the Geometry menu are “Define Point and Define 
Plane.” These commands are not for making measurements but for helping the viewer see 
symmetry aspects of a molecule or to clarify the structure in some way. The “Define Point” 
command allows us to highlight any atom or multiple atoms as points for reference. Defined 
points are visible on models when the point lies on an atom. From plane geometry, three 
points define a plane. The “Define Plane” command allows us to visualize a plane that is 
common to any three atoms by selecting those atoms. This tool can be very useful in helping 
a beginner visualize organic molecules. The five options for making measurements or 
defining points or planes in the geometry menu are also accessible by five icons on the 
toolbar. Collectively, these five icons along with six others that we shall use next semester 
are known as the Geometry Toolbar. 

Geometry Toolbar
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  ◦Measure Distance With methane on the screen in a ball and wire model, 
click “Measure Distance” from the “Geometry” menu or click the “Distance” icon. Enlarge 
the model if necessary. Click on any H and then the C atom. What is the H—C bond length? 
_______Å Find the bond length in the lower right corner of the screen. Find the bond length 
of any other H—C bond.______ Å Note: After you measure one distance by clicking two 
atoms, you can continue directly to the next measurement without clearing the last operation. 
How does the first H—C bond length compare to the second H—C bond length in methane? 
_________________________________________________ From your measurements, what 
is the carbon—hydrogen bond length, rounded to one decimal place, when carbon is sp3 
hybridized? _________ Å Alternatively, you can click on the midpoint of a bond to find the 
distance between two bonded atoms. Click on any C—H bond where the gray and white 
halves meet. Read the bond distance at the bottom right corner of the screen. Note that the 
selected atoms are highlighted by the appearance of a larger circle around the atom. A 
selected bond changes from half gray-half white to a solid metallic color. 
 
  ◦Measure Angle With methane on the screen, click “Measure Angle” from 
the Geometry menu or click the “Angle” icon. Click on any H, the C, and another H in that 
order. Rounded to one decimal place, what is the H—C—H angle? __________ Verify that 
all H-C-H bond angles in methane are identical. 
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  ◦Measure Dihedral Build a model of ethane and click “E” and “V.” Click 
“Measure Dihedral” from the Geometry menu or click the “Dihedral” icon. Click in turn on 
bonded atoms H-C-C-H. Rotate the molecule so that one C atom completely obscures the 
other C atom. The angle made by these three highlighted atoms is called the dihedral angle.  

 
 
A dihedral angle is an apparent angle made by four atoms, one of which is obscured. The 
value is found in the box at the bottom right of the screen. The program measures the angle 
from the near bond to the rear bond. If the angle generated by going from the near bond to 
the rear bond is clockwise, the angle is a positive or (+) angle. A corresponding 
counterclockwise angle is negative. We are generally more interested in the magnitude than 
we are of the sign of a dihedral angle. Make another dihedral measurement by clicking on 
one different H atom but re-clicking on three atoms selected before.  
 
  ◦Define Point Build a model of methane, open the Model menu and ensure 
that the Ball and Wire and Hydrogens options are checked. Click “Define Point” from the 
“Geometry” menu or click on the “Define point” icon. Click on the carbon atom. The carbon 
atom is highlighted. In turn, click on each of the H atoms. Each H atom is highlighted as you 
click it. When every atom in your model has been highlighted, click any of the highlighted 
atoms. The model reverts to a ball and wire model with no highlighted atoms. With the 
define point command active, take care to click in the center of the carbon atom. The carbon 
atom is highlighted. Click in the center of the C atom again. The highlight is removed and the 
model appears to be the same as is was before. Click on the “V” icon, and then select “Wire” 
from the “Model” menu. You see that the carbon atom is now the “defined point.” Thus, 
double clicking an atom when the Define Point command is active creates a visible marker 
on wire models. The defined point is invisible in the other models. Clear the model from the 
screen, and build a new ball and wire model of methane. Click “Define Point” from the 
“Geometry” menu. Click on carbon, then any hydrogen, then on carbon again. A point is 
created midway between the two atoms. This point is visible on the ball and wire model 
because the point does not coincide with an atom. Three clicks are required to make a point 
between two atoms; whereas, only two clicks are required to make an atom a point. Points 
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can be made at the midpoint of any bond in the model and on any atom. All points are visible 
on the wire model. Clear the screen. 
 
  ◦Define Plane With a new ball and wire model of methane on the screen, 
click “Define Plane” from the “Geometry” menu or click the “Define plane” icon. Click on 
the carbon and on two hydrogen atoms. A plane, connecting the three atoms, appears. Click 
on carbon and on the other two hydrogen atoms. A new plane appears. Select both 
“Hydrogens” and “Labels” from the “Model” menu. The hydrogen atoms disappear, and the 
planes are labeled Plane 1 and Plane 2. Select “Wire” from the “Model” menu. What is the 
relationship between Plane 1 and Plane 2? 
______________________________________________________ 
Hint: rotate the molecule so that neither plane is visible. The above examples show how the 
point and plane options can be helpful in the visualization of models. 
 
►User Options◄ Most user options are associated with the Options menu. 
 
 ●Options On the right side of the Menu Bar, click on “Options” to open the options 
menu. You see six options above a line, five in the middle and three options below the 
bottom line. The five options already checked are active or visible on your screen. The six 
options above the line are “About …, Preferences …, Colors, Fonts, Monitor, and 
Calculator.”  
  ◦About Spartan….. Click “About …” from the “Options” menu. A window 
opens that provides information on how to contact Wavefunction, the company that makes 
Spartan software.  
 
  ◦Preferences With methane on the screen in a ball and spoke model, click on 
“Preferences” from the “Options” menu. A new window labeled Preferences opens. The 
preferences window contains four sub-menus, “Miscellaneous, Molecule, VDW Radii, and 
Paths.” The Miscellaneous sub-menu is active. Select “large icons” from the dropdown menu 
called Toolbar Style. Then click the box labeled “Apply.” Click the Molecule sub-menu and 
select “Ball and Spoke” from the dropdown menu called Model. Then click “Apply” and 
“OK.” If the preferences window obscures your model, move one or both of them in the 
usual manner so that methane is visible on your screen. The preferences window can be 
moved by depressing and holding the LMK with the pointer in the blue field in which the 
word Preferences appears, and then dragging the window to the desired location on the 
screen with the LMK depressed.  
 
  ◦Colors Click on “Colors” from the “Options” menu. A new window called 
Set Color appears. This window controls the background color you see on the screen. The 
default color is a green background. The Set Color window contains three scrollable options 
made up of the three primary colors, Red, Green, and Blue. Depress and hold the LMK on 
the scrollbar under “Blue.” With the LMK depressed, scroll the bar upward and notice that 
the screen turns blue. With the three scrollable keys, you can adjust the background color on 
the screen to any color you please. Make several color adjustments, then click the “Default” 
option. The original green background color returns. Adjust the background color to the color 
of your choice. There are two red boxes on your screen with an X. Take care to be in the Set 
Color box and click the X in the upper right corner of the active window. The new 
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background color remains active until changed. If you accidentally click the wrong red box, 
you must reload Spartan.  
 
  ◦Model Kit, File Toolbar, Build Toolbar, Geometry Toolbar, Search 
Toolbar Click on “Options” to open the options menu. Five items are already checked. 
Checked items are visible on your screen. When you click on a checked item, the check 
disappears and the Kit or Toolbar disappears. Checking the item causes it to reappear on the 
screen. 

 
Before going on to the next section, make sure the Model Kit, Build Toolbar, and Geometry 
Toolbar are checked in the Options menu. Likewise, make sure that a Toolbar Style (i.e., 
small, medium or large icons) is selected in the Preferences window of the Options menu. 
 
►Keystrokes◄  
 
►Keystrokes for Manipulating Molecules in Spartan The keystrokes for the fundamental 
manipulations possible in Spartan are given in Table 1. 
 
Table 1. Keystrokes for Spartan 
 
    Operation 
 

 
     Mode 

 
Keystrokes 

Translation 
Single Molecule 
All Molecules 
One of Multiple Molecules 

 
 
 
(+) highlighted 

 
RMK 
RMK 
Ctrl + RMK 

Rotation (three-dimensional) 
Single Molecule 
All Molecules 
One of Multiple Molecules 

 
 
 
(+) highlighted 

 
LMK 
LMK 
Ctrl + LMK 

Spin (two-dimensional)  
Single Molecule 
All Molecules 
One of Multiple Molecules 
About single bond 

 
 
 
(+) highlighted 
(+) select bond (dashed) 

 
Shift + LMK 
Shift + LMK 
Ctrl + Shift + LMK 
Alt + LMK 

Zoom 
Enlarge Molecule 
Reduce Molecule 

  
Shift + RMK (mouse ↑) 
Shift + RMK (mouse ↓) 

Change Bond Length 
Lengthen 
Shorten  

 
(+) select bond (dashed) 
(+) select bond (dashed) 

 
Alt + RMK (mouse ↑) 
Alt + RMK (mouse ↓) 
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Molecular Modeling Exercises 
 
The following exercises are designed to allow you to collect useful information about organic 
molecules while exploring the build, view, and measure features of Spartan. The 10 questions 
at the conclusion of this lab require you to use your data. Therefore, answer the questions as 
you go along and keep them for the follow-on problems that must be turned in for a grade. 
 
Functional Groups: Functional groups are unique partial structures that allow us to classify 
organic compounds into families. Because each member of the family contains the same 
functional group, each member of the family reacts similarly. There are many organic 
families, which we can sub-divide into three major categories. These categories are (1) 
hydrocarbons, (2) compounds that contain a heteroatom, and (3) compounds that contain a 
carbonyl group. It is important to be able to identify functional groups, because they define 
the reactivity of the families to which they belong. Structure begets reactivity! 
 
Hydrocarbons: Hydrocarbons are compounds that contain only carbon and hydrogen. They 
may contain rings (i.e., be cyclic) or they may not contain any rings (i.e., be acyclic). The 
hydrocarbons are sub-divided into several families, depending on their structures. We shall 
consider the various hydrocarbon families. 
 
Though hydrocarbons contain no heteroatoms, they may contain any combination of π bonds 
and rings. The number of π bonds and their locations within a given structure determines the 
family to which a given hydrocarbon is assigned. Hydrocarbons may have no multiple bonds 
or a double bond, a triple bond, or alternating single and double bonds in a six-membered 
ring. The families are alkanes, alkenes, alkynes, and arenes, respectively. Figure 3 shows 
examples of these families. The next several exercises relate to these four compounds. 
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Figure 3. Hydrocarbon Families 
 
●Alkanes: Alkanes are hydrocarbons that contain no π bonds, only σ bonds. Alkanes may be 
cyclic or acyclic. Cyclic alkanes are called cycloalkanes. Alkanes are unique, because they 
do not contain an identifiable functional group. 
 
Note: Refer to Figure 3 for the numbering systems when answering the questions about 
hydrocarbons. The ball and wire model is recommended for the following exercises.  
 
 
►Ethane: From your studies, what is the hybridization of an alkane carbon atom? _____ 
Build and minimize a model of ethane. Make and record the following measurements for a 
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typical alkane. C-H bond length __________ C-C bond length _________ H-C-H bond angle 
_________   
 
●Alkenes: Alkenes contain one double bond that is made up of one σ bond and one π bond. 
A compound that contains two double bonds is called a diene, and one with three double 
bonds a triene, etc. Alkenes react primarily at the double bond or functional group. 
 
► From your studies, what is the hybridization of an alkene carbon atom? _____ Build and 
minimize a model of propene. See Figure 3 for numbering. What is the shape of the molecule 
around the double bond? ____________________ (Shapes are visible but not specified by 
the program, you must identify the shape.) What is the C1 to H1 bond length? ____________ 
What is the C1 to C2 (alkene) bond length? ___________  What is the H1 to C1 to C2 
(alkene) bond angle? _______________   
 
●Alkynes: Alkynes contain one triple bond that is made up of one σ bond and two π bonds. 
A compound that contains two triple bonds is called a diyne, and one that contains three is a 
triyne, etc. Alkynes typically react at the triple bond or functional group. 
 
►Build, minimize, and label a model of propyne. See Figure 3 for numbering; what is the 
hybridization of C1? __________ What is the shape of the molecule around the triple bond? 
______________________ What is the C1 to H bond length? _____________ What is the 
C1 to C2 (alkyne) bond length? ____________ What is the C1 to C2 to C3 (alkyne) bond 
angle? ________________  
 
●Arenes: Arenes contain an aromatic ring, a six-membered ring with alternating single and 
double bonds. Benzene is the first or simplest member of the arene family.   
 
► Build a model of benzene, using the Rings command, and minimize the structure. What is 
the hybridization of all of the C atoms? __________ What is shape of the whole molecule 
(hint: rotate it, if necessary)? ______________________ What is the C1 to H1 bond length? 
_____________ What is the C1 to C2 (arene) bond length (Note, see Figure 3 for 
numbering)? ____________  What is the C1 to C5 bond length? _____________ What is the 
C1 to C2 to C3 (arene) bond angle? ________________ 
 
Isomers: Isomers have the same formula (i.e., the same numbers and kinds of atoms) but 
differ in structure. There are several different kinds of isomerism. Two of the most important 
kinds are constitutional isomerism and cis—trans isomerism. 
 
●Constitutional Isomers:  Constitutional isomers differ in the way their atoms are 
connected to each other (i.e., their connectivity). Figure 4 shows three alkanes that each 
contains five carbon atoms. 
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Figure 4. Five-carbon alkanes 
 
►Build models of pentane, 2-methylbutane, and 2,2-dimethylpropane on the same screen, 
and scale them to fit on the screen so that all of them are visible. Minimize but do not label 
the structures. What is the molecular formula of pentane? _______________, of 2-
methylbutane? ____________, and 2,2-dimethylpropane? _________________ Are these 
compounds isomers? ____ What kind of isomers? __________________________________ 
Measure the distance between the terminal carbon atoms (IUPAC numbering) in each 
compound. C-1 to C-5 in pentane _______ C-1 to C-4 in 2-methylbutane _____ and C-1 to 
C-3 in 2,2-dimethylbutane ________ Change the models to space-filled models. If they 
overlap, go to build (+), and move and or scale the molecules so that each is observable. 
Which compound is most compact (most closely resembles a ball)? 
_______________________________Which compound is least compact? 
_____________________________  
 
●cis—trans Isomerism: Cis is a term that means two groups are on the same side of a 
molecule, and trans means that two groups are across from each other in a molecule. In order 
to have cis—trans isomers, the molecule must clearly have two identifiable “sides.” The 
necessary condition for cis—trans isomerism is afforded by carbon—carbon double bonds 
and rings (i.e., alkenes and cyclic compounds). Figure 5 shows how the two “sides” are 
identified.  
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Figure 5. Cis-trans Isomerism 
 
The double bond of an alkene determines the “sides.” The double bond is extended as shown 
by the dashed magenta line in Figure 5, and the sides lie on either side of the magenta line. 
For a cycloalkane, the ring determines the sides. Though most rings are not planar, once a 
structure is drawn, we can clearly identify whether a group is one side or the other as shown 
in red and blue in Figure 5. In general, we compare only two groups at a time. Cis means the 
two groups we mention are on the same side (either red or blue in Figure 5). Trans means the 
two groups we mention are on opposite sides of the ring and across the ring; two groups that 
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are trans are not bonded to the same atom. Thus, A and E are not trans in either structure of 
Figure 5. For the alkene, A and B and E and F are cis; A and F and B and E are trans. For the 
cylcoalkane, A is cis to B and to D; A is trans to F and to G but not to E. Note that A and B 
are on the same side of the ring but not next to each other. Cis only means “same side.” 
Cis—trans isomers do not differ in connectivity. Exactly the same atoms are bonded to each 
other in both compounds. Cis—trans isomers differ in their three-dimensional geometry. 
They are one example of stereoisomers. We shall cover other examples of stereoisomers later 
in the course. 
 
►Build models of the compounds shown in Figure 6 on the same screen and minimize. 

 
Figure 6. Two 2-Butenes 
 
In one of the molecules, the two methyl groups are on the same side and in the other they are 
across from each other. Give complete names for these compounds, including the 
stereochemical prefixes cis and trans. __________________________________________ 
and __________________________ The prefix precedes the rest of the name. When cis or 
trans becomes part of a name, it is italicized. For example, cis-1,3-dimethylcyclopentane. In 
the future, when you see cis as an italicized prefix, be aware that there is a corresponding 
trans stereoisomer! Change the view to space filling. Which of the space-filled molecules 
seems to be more compact?_____________________  
 
►Build models of the compounds shown in Figure 7 on the same screen of and minimize. 

CH3 CH3 CH3

CH3

 
Figure 7. Two dimethylcyclobutanes 
 
Name these compounds, ______________________________________________________ 
and ______________________________________________________________________. 
According to your models, does either of the compounds have a perfectly planar ring? 
_______ Explain any differences you observe in the Spartan models vs the structures as they 
appear in Figure 6. 
___________________________________________________________________________
___________________________________________________________________________ 
Measure the angle made by any three of the ring carbon atoms. _________ Subtract your 
answer from the tetrahedral angle of 109.5o? ____________ The difference is a measure of 
the angle strain in the molecule. Angle strain is the number of degrees the normal tetrahedral 
angle is compressed from its normal value of 109.5o. Start with either red carbon atom of 
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Figure 6 in the cis-isomer and measure the dihedral angle made by the four carbon atoms, 
red-ring-ring-red. _________ The smaller the dihedral angle, the greater is the torsional 
strain. In the trans-isomer, measure the dihedral angle made by the four carbon atoms blue-
ring-ring-blue. ______________ Which isomer has the greater torsional 
strain?_____________ View the molecules as space-filled models. Locate the two methyl 
groups in each model. When adjacent groups are closer together than the sum of their van der 
Waals radii, both groups try to occupy the same space. When two groups touch each other, 
we call it a steric (spacial) interaction. The stain that a spacial interaction places on a 
molecule is called steric strain. Which isomer has the greater steric strain? 
____________________ 
 
Organic Families Containing a Single-bonded Heteroatom: Heteroatoms are any atoms 
other than carbon or hydrogen. For most purposes, heteroatoms are nitrogen, oxygen, sulfur, 
or a halogen (fluorine, chlorine, bromine, or iodine). Although nitrogen, oxygen, and sulfur 
can form multiple bonds, this group of families contains a heteroatom and no multiple bonds. 
Examples of families in this group are alkyl halides, alcohols, ethers, amines, thiols, and 
sulfides. Ethers and sulfides are derivatives of alcohols and thiols, respectively. They will be 
covered later in the course. Figure 8 shows an example of an amine, an alcohol, a thiol, and 
four alkyl halides.  
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Figure 8. Families with Single-bond Heteroatoms 
 
The families are arranged in Figure 8 according to the location of the heteroatom in the 
periodic table. Note that nitrogen has three bonds, oxygen and sulfur two bonds each, and 
fluorine, chlorine, bromine, and iodine one bond each, a reflection of the periodic groups of 
these atoms. The methyl group in each of the structures is the organic part, the colored part of 
each molecule is the functional group that defines the family. Reactions involving these 
molecules generally occur at the functional group. The four alkyl halides are considered to be 
one family with four sub-families. The names of the specific compounds in Figure 8 are 



                              21

methylamine, methanol, methanethiol, and methyl fluoride, methyl chloride, methyl bromide, 
and methyl iodide. 
 
●Alkyl Halides: Alkyl groups are alkanes with one H atom missing. When the missing H is 
replaced by a halogen, F, Cl, Br, or I, the compound is an alkyl halide.  
 
►Build models of methyl fluoride, methyl chloride, methyl bromide and methyl iodide and 
minimize them. While still in the build mode, rotate each model so that the halogen atom 
completely obscures the carbon atom. Arrange the molecules left to right, fluoride, chloride, 
bromide, and iodide. View the models as space-filled models. What is the order of increasing 
size of the halogen atoms? ______________     
 
●Alcohols:  Alcohols contain an alkyl group and a hydroxyl group (-OH), the functional 
group. The hydroxyl group (-OH) replaces the missing H atom. If you start with water (H-O-
H) and replace one of the H atoms with an alkyl group, you make an alcohol. Alcohols 
generally react at the OH group. 
 
►Build two models of methyl alcohol on the same screen. The second model is active (has 
yellow tips). Move it so that the yellow tip from the red oxygen touches the red oxygen of the 
first molecule, and the alkyl part of the second alcohol is as far away from the first alkyl 
group as possible. Build a third model of methyl alcohol. Move it so that its H from OH just 
touches the red O of the second model, while ensuring that the alkyl groups are as far from 
each other as possible. Click E to minimize. You have an array of three molecules. There is 
an endless array of methyl alcohol molecules in a sample of methyl alcohol. Hydrogen 
bonding exists in organic compounds when an H atom is bonded to either an N or O atom 
and is attracted through space to another N or O atom. Hydrogen bonds are strong dipole—
dipole forces of attraction. When hydrogen bonding is present in liquids, the boiling point of 
the liquid is higher than that of non-hydrogen bonded compounds of comparable mass. Does 
your array of molecules depict hydrogen bonding? ________ Describe hydrogen bonding in 
alcohols. _________________________________________________________________ 
_________________________________________________________________________ 
 
●Amines: Amines contain an alkyl group and an amino (-NH2) group, the functional group. 
Amines generally react at the –NH2 group. 
 
►Build a model of methylamine and minimize the structure. Can you distinguish the carbon 
atom from the nitrogen atom by color? _______ By number of H atoms bonded to the N 
atom? ______ Make the model as large as possible but still on the screen. Now, can you 
distinguish N from C in the model? ______ What color is the C atom? ______ The N atom? 
______ In a Lewis structure of methyl amine, the N atom has a lone pair of electrons. Where 
is the lone pair in the model? 
 
●Thiols: Thiols contain an alkyl group and a mecapto group (-SH), the functional group. The 
prefix thio means sulfur, so thiols are –ols (alcohols) that contain sulfur instead of oxygen. 
Indeed, thiols can be considered compounds in which the O of an alcohol has been replaced 
by S. Thiols are important in certain biochemical processes. Thiols generally undergo 
reactions in which the mercapto group participates. 
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►Build a model of methanethiol and minimize it. What color is the sulfur atom in the 
model? __________ 
 
Organic Families Containing a Carbonyl Group: A carbonyl group is a carbon and 
oxygen atom joined by a double bond. The carbon atom of the carbonyl group has two open 
or free valences.  
 

C
O

carbonyl group

squiggly indicates
open valence

 
 
Several different kinds of groups or atoms can be bonded to these two valences, giving rise to 
a number of families that contain the carbonyl group as a central structural feature. Examples 
of families in this group are aldehydes, ketones, carboxylic acids, esters, amides, and acid 
chlorides. For convenience, this group can be broken into two sub-groups. One group is 
aldehydes and ketones. The other group is carboxylic acids and the derivatives of carboxylic 
acids. 
 
●Aldehydes and Ketones: Aldehydes and ketones contain a carbonyl group but no 
additional heteroatoms. Aldehydes must contain one H atom bonded directly to the carbonyl 
carbon atom. If both of the free valences of the carbonyl group are bonded to H atoms, the 
compound is the aldehyde called methanal or formaldehyde. Ketones must contain two 
carbon atoms bonded to the carbonyl carbon atom. Figure 9 shows examples of aldehydes 
and ketones. The carbonyl group is shown in blue. 
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Figure 9. Aldehydes and Ketones 
 
►Build models of formaldehyde, acetaldehyde and acetone on the same screen and click E. 
Measure and record the oxygen to carbon double (carbonyl) bond length in each. _______ 
_______ and ____________ Measure and record one angle in each compound in which the 
carbonyl carbon is the middle atom. _______ _________ _________ View the molecules as 
tubes. What is the geometry around the carbonyl group? _____________________ What 
structural feature is necessary for a pure sample of a given compound to form intermolecular 
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hydrogen bonds? __________________________________________From the structures in 
Figure 9, can a pure aldehyde form intermolecular hydrogen bonds? ____________ 
 
●Acids and Acid Derivatives: Carboxylic acids contain a hydroxyl group bonded directly to 
the carbonyl carbon. Esters, amides, and acid chlorides are derivatives of carboxylic acids in 
which the H or OH of the acid’s hydroxyl group has been replaced. Acids and acid 
derivatives are characterized by a heteroatom bonded to the carbonyl carbon. Figure 10 
shows examples of these families. The carbonyl group is shown in blue. The heteroatom 
bonded to the carbonyl carbon in these compounds is highlighted in red. 
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Figure 10. Acetic Acid and its Acid Derivatives 
 
►Build and minimize a model of acetic acid. View the molecule as a ball and spoke model. 
Change the model, in turn, into ethyl acetate, acetamide, and acetyl chloride. Change acetyl 
chloride into acetyl bromide. What is the structure of the acetyl group?________________ 
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Questions Electronic Models 
 
1. What angle strain did you find in the cyclobutane ring? _________  
 
2. Why isn’t the cyclobutane ring planar? 
 
 
3. From your lab results, which stereoisomer, cis-1,2-dimethylcyclobutane or trans-1,2-
dimethylcyclobutane, has the higher overall strain (i.e., sum of angle, torsional, and steric 
strains)? 
 
4. From your lab results, what is the relationship between branching in alkane constitutional 
isomers and the compactness of the molecules?  
 
When a compound boils, the molecules of the compound are separated (pushed apart) by the 
application of heat. In a series of isomeric compounds, the most heat is required to separate 
the molecules of the isomer with the strongest intermolecular forces. Thus, that isomer has 
the highest boiling point of the group. Likewise, the least amount of heat is required to 
separate the molecules of the isomer with the weakest intermolecular forces. Thus, that 
isomer has the lowest boiling point of the group. In the alkane family, what is the relationship 
between compactness and intermolecular forces? 
 
Finally, for the alkane family, what is the relationship between compactness and boiling 
point? 
 
From your analysis, rank pentane, 2-methylbutane, and 2,2-dimethylpropane in order of 
increasing boiling point. 
 
 
 
 
 (Use the Internet to verify your conclusion. If your initial conclusion is incorrect, go back 
through this question until you understand: small diameter space-filled model = compact 
molecule = weak intermolecular forces = low bp.) 
 
5. From your lab results, what is the bond length of the double bond in a carbonyl group, 
rounded to two significant figures?  
 
6. Does methanol or methanal (formaldehyde) have the higher boiling point? 
Explain why your answer is correct. 
 
 
7. What is the hybridization of a carbonyl carbon atom? 
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8. Write the family name beneath each of the structures. 

CH3CH2COH

O

CH3CH2CH

O
CH3CH2COCH2CH3

O

 
       
 
9. Explain how torsional strain is a function of dihedral angle. 
 
 
 
 
 
10. From your experimental results, complete the following table. 
 
Kind of Bond 
 

 
             Structure  

 
Bond Length  
(rounded to 0.1 Å) 

 
sp3 carbon-hydrogen 
 

 
               C-H 

 
      1.1  

 
sp2 carbon-hydrogen 
 

 
 
 

 

 
sp carbon-hydrogen 
 

 
 
 

 

 
sp3 carbon- sp3 carbon 
 

 
 
 

 

 
sp2 carbon- sp2 carbon 
 

 
 

 

 
sp carbon- sp carbon 
 

 
 
 

 

 
arene carbon-arene carbon 
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